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Software License 
 

 DMT licenses WIBS software only upon the condition that you accept all of the terms contained in 

this license agreement.  

This software is provided by DMT “as is” and any express or implied warranties, including, but not 

limited to, the implied warranties of merchantability and fitness for a particular purpose are 

disclaimed. Under no circumstances and under no legal theory, whether in tort, contract, or 

otherwise, shall DMT or its developers be liable for any direct, indirect, incidental, special, 

exemplary, or consequential damages (including damages for work stoppage; computer failure or 

malfunction; loss of goodwill; loss of use, data or profits; or for any and all other damages and 

losses).  

Some states do not allow the limitation or exclusion of implied warranties and you may be entitled to 

additional rights in those states. 

 

Laser Safety 

 

The WIBS-4A is a Class 1 Laser Product. It features a 635 nm, 12 mW laser. 

 

An identification label is located on the rear panel of the WIBS. 

 

CAUTION – Use of controls or adjustments or performance of procedures other than those 

specified herein may result in hazardous radiation exposure. 



Manual, Wideband Integrated Bioaerosol Spectrometer  

 

DOC-0345 Rev A-2 I V  
© 2013 DROPLET MEASUREMENT TECHNOLOGIES, INC.  

C O N T E N T S  

 

1.0 Introduction .............................................................................. 6 

2.0 Unpacking ................................................................................ 6 

3.0 Overview of Operation ................................................................ 7 

3.1 Design.......................................................................................... 7 
3.2 Particle Detection Thresholds T1 and T2 ................................................ 10 

3.2.1 T1 Threshold ............................................................................ 11 
3.2.2 T2 Threshold ............................................................................ 11 

3.3 Components.................................................................................. 11 
3.4 Aerosol Sampling System................................................................... 12 

3.4.1 System Diagram ........................................................................ 12 
3.4.2 Aerosol Flow ............................................................................ 13 
3.4.3 Oversize Particle Trap (OPT) and OPT Removal ................................... 14 

4.0 Quick-Start Navigation ............................................................... 15 

5.0 WIBS Software ......................................................................... 16 

5.1 Main Window ................................................................................ 17 
5.1.1 User Controls and Displays ........................................................... 17 
5.1.2 Menus .................................................................................... 19 

5.2 Plots Window ................................................................................ 19 
5.2.1 Particle Data Plots ..................................................................... 21 
5.2.2 Diagnostic Plots ........................................................................ 21 
5.2.3 Menus .................................................................................... 22 

5.3 Scatter Plot .................................................................................. 24 
5.3.1 Menus .................................................................................... 24 
5.3.2 Other functions, 2D and 3D modes .................................................. 25 

5.4 Frequency Plot .............................................................................. 26 
5.4.1 Y axis .................................................................................... 27 
5.4.2 X axis..................................................................................... 27 

6.0 Maintenance ........................................................................... 27 

6.1 Zero-Count Check ........................................................................... 28 
6.2 Cleaning the Inlet Assembly ............................................................... 28 

Appendix A:  Specifications ............................................................... 29 

General Specifications ............................................................................ 29 
Physical Specifications ............................................................................ 29 

Appendix B: Particle Size and Shape Determinations ............................... 30 

Particle Size ........................................................................................ 30 
Particle Shape ...................................................................................... 31 



Manual, Wideband Integrated Bioaerosol Spectrometer  

 

DOC-0345 Rev A-2 V  
© 2013 DROPLET MEASUREMENT TECHNOLOGIES, INC.  

Appendix C: Output Files .................................................................. 32 

File Format ......................................................................................... 32 
Output Channels ................................................................................ 32 

Appendix D:  WIBS-4A Delivery Settings ................................................ 36 

Appendix E: WIBS 4 Optical Filters ...................................................... 37 

Xe1 Filters .......................................................................................... 38 
Xe2 Filters .......................................................................................... 39 
Dichroic Beamsplitter ............................................................................. 40 
FL1 Channel ........................................................................................ 41 
FL2 Channel ........................................................................................ 42 
Quad-PMT Channel ................................................................................ 43 

Appendix F: Removing WIBS-4A Cover for Access .................................... 43 

Appendix G: References.................................................................... 44 

Appendix H: Revisions to the Manual ................................................... 45 

 

 

F i g u r e s  

 

Figure 1: The WIBS-4A ........................................................................ 6 

Figure 2: The WIBS-4A Central Optical Chamber ....................................... 8 

Figure 3: The WIBS-4A Measurement Cycle .............................................. 8 

Figure 4: Screen Display Showing Location of T1 and T2 Threshold Settings .. 10 

Figure 5: WIBS-4A Components ........................................................... 12 

Figure 6: WIBS-4A Aerosol Flow .......................................................... 13 

Figure 7: Smoke Visualization of Scattering Volume and its Surrounding Clean 

Sheath Flow .............................................................................. 14 

Figure 8: Oversize Particle Trap (left) and Removal of OPT ....................... 15 

Figure 9: WIBS-4A User Interface ........................................................ 16 

Figure 10: WIBS-4A Main Window ........................................................ 17 

Figure 11: WIBS-4A Plots Window ........................................................ 20 

Figure 12: WIBS-4A Scatter Plot .......................................................... 24 

Figure 13: WIBS-4A Frequency Plot ..................................................... 26 

Figure 14: Cleaning the Inlet Assembly ................................................. 28 

Figure 15: WIBS-4A Size Calibration Curve ............................................ 30 

Figure 16: Schematic diagram showing derivation of a particle Asymmetry 

Factor, AF, by measurement of the azimuthal variation in forward 

scattering from the particle. ......................................................... 31 



Manual, Wideband Integrated Bioaerosol Spectrometer  

 

DOC-0345 Rev A-2 6  
© 2013 DROPLET MEASUREMENT TECHNOLOGIES, INC.  

1.0 Introduction 

The Wideband Integrated Bioaerosol Spectrometer (WIBS) provides highly sensitive 

measurements of mold and other bioaerosols. The instrument uses a UV xenon source to 

excite fluorescence in individual particles. Unlike UV lasers, the UV xenon source allows 

for the precise selection of particular UV wavebands. On the WIBS, these wavebands have 

been selected to optimize detection of the common bioaerosol components tryptophan 

and nicotinamide adenine dinucleotide (NADH). The xenon source is also far less 

expensive than a UV laser, making the WIBS-4A a cost-effective alternative to other 

bioaerosol measurement instruments. 

 

The WIBS was originally developed by the University of Hertfordshire and is licensed to 

and manufactured by Droplet Measurement Technologies.  

 

 

Figure 1: The WIBS-4A 

 

This manual describes the WIBS-4A. 

2.0 Unpacking  

Unpack the WIBS-4A and ensure all the components are present. Shipped with 

your instrument are the following items:  
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 Laptop 

 Power supply 

 Zero filter and inlet adapter 

 USB storage device 

 This document, the Wideband Integrated Aerosol Spectrometer Operator Manual 

 

3.0 Overview of Operation 

3.1 Design 

 

The single-particle fluorescence sensor, WIBS-4A, employs a central optical chamber, 

shown in Figure 2, around which are arranged the following components: 

 

 A continuous-wave 635nm diode laser used in the detection of particles and the 

determination of particle size  

 A forward-scattering quadrant photomultiplier tube (PMT) used in the 

determination of particle size and shape  

 Two pulsed xenon UV sources emitting at different wavebands 

 Two fluorescence detection channels, FL1 and FL2, detecting intrinsic particle 

fluorescence across two wavebands.  

 

Thus, for each particle, a 2x2 excitation-emission matrix is recorded along with an 

estimate of particle size and particle shape. The excitation and emission bands are 

selected to optimize detection of biological particles containing tryptophan and NADH. 
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Figure 2: The WIBS-4A Central Optical Chamber 

In operation, aerosol is drawn from the ambient atmosphere via a laminar-flow delivery 

system. This system renders suspended particles in essentially single file as they traverse 

the focused laser beam. The total aerosol flow is approximately 2.5 l/min, of which 

approximately 2.2 l/min is filtered before being re-introduced to form a sheath flow. The 

sheath flow confines the remaining sample flow as well as a small bleed flow that 

continually purges the optical chamber of any fugitive particles. The intersection of this 

aerosol sample flow and laser beam defines the scattering volume, a circular disc 

approximately 0.7 mm diameter and 130 μm depth. 

 

 

Figure 3: The WIBS-4A Measurement Cycle 
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Each particle entering the scattering volume (position 1 in Figure 3) scatters light in all 

directions. The side-scattered light is collected by the two high numerical-aperture 

chamber mirrors and passes through an aperture in one of the mirrors, then through a 

dichroic beam-splitter, and onto the FL2 channel PMT. This produces an electrical scatter 

pulse, as shown in the oscilloscope plot in the right of Figure 3. (Note that light scattered 

in the forward direction falls onto a separate Quadrant PMT used to assess particle shape; 

see Appendix B). 

 

The magnitude of this pulse is compared to a pre-set threshold voltage, equivalent to a 

particle of approximately 0.5 μm in size. If the pulse size exceeds the threshold, the first 

xenon flash-tube, Xe1, is fired some 10μs later when the particle has travelled down to 

position 2 in Figure 3. This flash-tube is optically filtered to a narrow band centered on 

280nm (see Appendix E). The 280nm band is tuned to excite the specific target biological 

molecule tryptophan that may be present within the particle. The resulting fluorescent 

emission from the particle is collected by the two chamber mirrors and delivered through 

the mirror aperture onto the dichroic beam-splitter. Light of wavelength less than 400nm 

is reflected and passes through an additional bandpass filter1 to improve out-of-band 

blocking. The filtered light then falls onto the photocathode of the FL1 detector. Light 

being transmitted by the dichroic beam-splitter also passes through additional filters to 

improve out-of-band blocking, before falling onto the FL2 detector. Thus, simultaneous 

electrical pulses are recorded by the FL1 and FL2 detectors, proportional to the 

magnitude of fluorescence in the 310-400nm and 420-650nm bands, respectively. (See 

oscilloscope plot in Figure 3). 

 

The FL1 detector channel thus records the intensity of fluorescence corresponding to the 

peak emission band of tryptophan, and the FL2 detector channel corresponding to the 

emission band of the biofluorophore NADH. 

 

Approximately 10μs after the firing of the Xe1 xenon, the particle will have moved down 

further to position 3 in Fig.2. The Xe2 xenon flashlamp is then fired, again illuminating 

the particle with an intense UV pulse. The Xe2 flashlamp is optically filtered to emit a UV 

band that corresponds to the peak excitation wavelength of the biofluorophore NADH. 

Again, the fluorescence from the particle is collected by the chamber mirrors before 

being split by the dichroic beam-splitter to the FL1 and FL2 detection bands, resulting in 

further electrical pulses on the FL12 and FL2 channels, respectively (see Figure 3). 

 

                                            
1
 Further details of the optical filters used in WIBS4 are given in Appendix E. 

2
 Note the saturation of the FL1_370 pulse. This is because the Xe2 UV pulse (370nm) lies in the 

detection band of FL1 (310-400nm) and therefore the detector receives not only fluorescence light 

from the particle, but also elastically scattered UV at 370nm. The elastically scattered light is 

typically 3 orders of magnitude larger than the fluorescence and therefore temporarily saturates the 

detector. The FL1_370 measurement is therefore ignored. 
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The magnitudes of the scatter pulse and the three useable fluorescence pulses are 

measured and stored by the WIBS-4A electronics, along with other useful parameters. The 

whole measurement cycle for the particle takes approximately 25μs, during which time 

the particle moves approximately 300μm downwards. 

 

After particle measurement, the xenons are recharged for a period of ~5ms, during which 

time any particles passing through the scattering volume will be counted but no 

fluorescence measurements will be recorded. The xenons are capable of firing at a 

maximum rate of approximately 125/s. Thus, all particles may be measured for particle 

concentrations up to ~2x104 particles/liter. 

 

3.2 Particle Detection Thresholds T1 and T2 

The WIBS-4A has two user-selectable particle detection Thresholds, T1 and T2. T1 is 

always less than or equal to T2. The threshold settings can be accessed from the WIBS 

software (see Figure 4). 

 

Figure 4: Screen Display Showing Location of T1 and T2 Threshold Settings 

Each Threshold can be set by the user via the laptop screen display and can have a value 

up to 256.  
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3.2.1 T1 Threshold 

The T1 threshold is the Particle Detect threshold. When the particle passes through the 

laser beam and scatters light to the FL2 channel detector, the signal voltage pulse 

produced by the detector is compared to the T1 threshold and if greater than T1, the 

particle will be counted. This occurs for particles greater than about 0.5μm in diameter. 

 

The normal minimum setting for the T1 threshold is just above the level at which 

electrical noise can cross the threshold and trigger the instrument. Normally this occurs 

for a T1 value of about 6. The method for testing this is to gradually reduce the T1 level 

with the WIBS-4A pump OFF. No particles should be registered as counted, but eventually 

the threshold will drop into electrical noise and “false” particles will be counted. The T1 

threshold should then be raised 2 steps above this noise floor. In very electrically noisy 

environments, such as those with heavy machinery, T1 may need to be raised higher to 

avoid triggering on noise. 

 

3.2.2 T2 Threshold 

The WIBS-4A also has a second trigger, Threshold T2. This can be set equal to or higher 

than T1, and a full particle measurement will only occur if T2 is crossed (as well as T1). 

For example, if T1 = 6 and T2 = 15, then all of the small particles will be counted but 

only the larger particles will be measured in full. 

 

The T2 threshold was implemented to allow users to focus on particles in larger size 

ranges. Earlier versions of the instrument did not have a T2 threshold. In these 

instruments, as soon as the T1 threshold was crossed and a particle detected, the full 

measurement cycle would take place at up to the maximum of ~125 times per second. In 

many applications this would be perfectly acceptable. However, if the user was 

interested in, say, particles of 5 -10 μm in diameter within an ambient aerosol that 

contained a far higher population of 1-2 μm particles, then statistically far more of the 

(unwanted) smaller particles would be measured.  

 

3.3 Components 

The main components of the WIBS-4A are shown below. 
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Figure 5: WIBS-4A Components 

1 Aerosol inlet 

2 

USB and power con-

nectors, air sample 

outflow, LED indicators 

3 Oversize particle trap 

4 Pump 

5 Main optical chamber 

6 Xenon sources 

7 
Fluorescence detection 

channels 

8 
Quadrant PMT, particle 

“shape” detector 

9 Power distribution Board 

10 
Analog acquisition and 

digitization board 

 

 

 

3.4 Aerosol Sampling System 

3.4.1 System Diagram 

Figure 6 shows a section view of the aerosol flow though the WIBS-4A. 

 

1 

2 
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Figure 6: WIBS-4A Aerosol Flow 

 

 

3.4.2 Aerosol Flow 

Once the aerosol has entered the Inlet assembly, the majority of the flow (approx. 90%) 

is directed through a HEPA filter and then returned as both a sheath flow (to surround the 

sample flow with particle-free air) and a small bleed flow of clean air into the chamber. 
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The sheath flow has the effect of constraining the sample flow as the two flows pass 

through the tapered delivery nozzle, as illustrated in Figure 7 below. 

 

 

Figure 7: Smoke Visualization of Scattering Volume and its Surrounding Clean Sheath Flow 

In WIBS-4A, the set total aerosol flow rate is approximately 2.5 liters/min, and the 

sample flow rate ~300 ml/min. (see Appendix D for exact delivery settings). The 

scattering volume, defined by the intersection between the laser beam and the sample 

airflow column, is approximately 0.7mm diameter and 130μm deep. The flow velocity at 

this point is typically ~12 m/s. 

 

The full aerosol flow (sample + sheath + bleed) is drawn out of the chamber by the WIBS-

4A sampling pump via a HEPA filter. The outflow of the pump is delivered to a vent port 

adjacent to the LED status lights on the WIBS-4A connector panel. 

 

3.4.3 Oversize Particle Trap (OPT) and OPT Removal 

At the top of the WIBS-4A chamber the aerosol is first drawn through an Oversize Particle 

Trap (OPT). The OPT device serves to remove very large particles within the airflow and 

therefore prevent possible blockage of the delivery nozzle, which has a 1.2mm exit 

diameter. The OPT contains a simple airflow deflector around which the airflow is 

forced.  

 

If the WIBS-4A is being operated in an environment where extremely large particles (such 

as organic fibers of mm length) are unlikely, then the airflow deflector is not necessary 

and should be removed. This is done by unscrewing the three retaining screws holding the 

OPT lid, as in Figure 8 below, then removing the deflector and replacing the lid. 

 

Annular sheath flow 
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Figure 8: Oversize Particle Trap (left) and Removal of OPT 

The OPT is connected to the main WIBS-4A inlet assembly by a short length of flexible 

silicone tubing. See Figure 6.  This is to prevent damage to the WIBS-4A chamber should 

the OPT receive a severe shock. 

4.0 Quick-Start Navigation 

To run the program, first make sure the WIBS instrument is switched on and its USB link 

connected. Then click on the WIBS shortcut that should be present in the Start Menu > 

All Programs list.  

 

When the program is started, a window will briefly appear showing progress while the 

WIBS firmware is being programmed. This only happens once each time the instrument 

power is switched on or the USB cable is connected. If either the power is cut or the USB 

cable is disconnected, the software must be restarted in order to reprogram the 

firmware. Do not disconnect the USB cable or switch of the power to the instrument 

without first closing the program. 
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Figure 9: WIBS-4A User Interface 

Once the program is running, do the following: 

 

1. Set a data output file. See Main Window > File menu > Set o/p file. 

2. Select the operation mode, “Forced Trigger” or “Acquisition,” using the Select 

Function drop-down list. “Acquisition” mode is the default. See the following 

section for additional information. 

3. Switch the pump on by clicking on the upper area of the Pump switch.  

4. Start the Forced Trigger / Acquisition function by clicking on the upper area of 

the Function switch.  

 

To stop data acquisition, click on the lower area of the Function switch. Stop the pump 

by clicking on the lower area of the Pump switch. 

 

For more details on the user interface, see the following section. 

5.0 WIBS Software  

The WIBS software consists of several windows: 

 The main window (upper right) 

 The plots window (left) 

 The scatter plots window (lower right) 

 The frequency plot (see Figure 13) 
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5.1 Main Window 

Figure 10 shows the WIBS-4A main window. 

5.1.1 User Controls and Displays 

Select Function is a control that 

determines the WIBS mode, as follows:  

 

“Acquisition” is the normal mode of the 

instrument. In this mode, when the pump is 

on, particle size, shape, and fluorescence 

data are recorded. 

 

In “Force Trigger” mode, the two Xenons 

are triggered periodically at approximately 

1 second intervals. This allows background 

data to be recorded for the three 

fluorescence channels in the absence of a 

particle. The background is due to second-

order effects such as filter fluorescence, 

filter breakthrough, and molecular 

fluorescence in the scattering volume. 

 

The Function switch starts and stops the 

selected Function (Acquisition or Forced 

Trigger). 

 

The Pump switch allows the user to turn the 

WIBS-4A internal-air sampling pump on or off. 

 

 
 

Figure 10: WIBS-4A Main Window 

Max Measurements per file sets the maximum number of particle measurements a single 

output file can contain. A new output file with an incremented index is automatically 

generated when the current output file is full. (This feature helps minimize data loss in events 

such as a power failure.) 

O/p filename displays name of user-specified output file. 

Data Information 
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Count T1 displays a running total of all Threshold 1 particle counts recorded in the output 

data file (see element TPCT1 in section on data output file. Total Particle Count T1 (TPCT1) is 

the total number of particles producing a signal above Threshold 1 that may pass through the 

scattering volume each time the xenons are recharging (approximately 5 ms in duration). The 

number includes Count T2 below. 

Count T2 displays a running total of all Threshold 2 particle counts recorded in the output 

data file. The Total Particle Count T2, TPCT2, is the total number of particles producing a 

signal above Threshold 2 that may pass through the scattering volume each time the xenons 

are recharging (approximately 5ms in duration). The number includes the count of measured 

particles. 

Count T2 measured displays a running total of all measured particles (i.e., particles with the 

full data set of size, shape, and fluorescence). 

Duration displays the time in d:hh:mm:ss format since the Function switch has been started. 

 

Thresh T1 is a slider control that adjusts the particle detection and counting trigger threshold 

of the instrument. In acquisition mode, this should be reduced until instrument starts 

triggering on noise, then raised 2 steps above the noise level. Normally the setting is 6, 

corresponding to a particle of ~0.5μm in size.3  All particles crossing the T1 threshold will be 

counted. 

Thresh T2 is a slider control that adjusts the particle measurement trigger threshold of the 

instrument. This threshold can only be set greater than or equal to Thresh T1. It can be raised 

above Thresh T1 if desired to allow the instrument to measure (i.e. full size, shape, and 

fluorescence data) only larger particles, while still counting the smaller particles that produce 

signals above Thresh T1. The T2 threshold can be raised to a maximum rate of ~125 

particles/second. 

Control Parameters 

These parameters control the timing of the sequence of events that occur each time a 

particle triggers the instrument (i.e., xenon flash timing). It is possible to alter these by 

clicking on the appropriate parameter in the Value column and entering a number. The 

number corresponds to a number of clock counts. It is translated into microseconds in the 

adjacent column in the Control Parameters box. If a change is made, the acquisition / forced 

trigger session must be stopped and restarted to allow the change to be applied to the 

instrument. The users should not change these settings without consulting DMT staff. 

 
                                            

3
 If the setting is reduced, the system will begin to trigger on noise pulses. In an environment of 

high electrical noise, the threshold may need to be raised to a point where, with the Pump off, 

no triggering of the xenons occurs. 
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Diagnostic information 

This displays information about the current status of the instrument. 

5.1.2 Menus 

5.1.2.1 File Menu 

File > Set o/p file sets file to record data to. An index number will be appended to this 

file. Every time a function is started, a new file will be created with an incremented 

index. A new incremented file will also be created when the measured data count 

reaches the number shown in the 'Max Measurements per file' text box (30,000), or when 

approx. 3 hours has passed since the last file was created.  

 

File > Save settings on exit  

If this menu item is checked, most of the software settings including instrument control 

parameters and software windows appearance will be saved when the program is closed.  

 

File > Exit closes the program.  

 

5.1.2.2 Plots Menu 

Displays the main plots window.  

 

5.1.2.3 Optimize Menu 

This is a diagnostic menu that the development staff use for internal instrument settings. 

It is not normally available to end-users, and may not be visible in some software 

versions. 

 

5.1.2.4 PMT Gain Menu 

This function is disabled on the DMT WIBS-4A. 

 

5.2 Plots Window 

The Plots Window (Figure 11) can display real-time rolling plots of all the data available 

from particle measurements. 
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Figure 11: WIBS-4A Plots Window 

The data types to be displayed are selected from the Plots menu. There are two general 

classes of Plots: 

 

 Particle Data Plots: Normal plots used to display particle measurement data 

(fluorescence, size and shape) 
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 Diagnostic Plots: Secondary instrument data, useful for diagnosing instrument 

performance 

5.2.1 Particle Data Plots 

Particle Data plots are shown in Figure 11. There are six data plots: 

 

 FL1_280: 310-400nm fluorescence detected by FL1 detector with Xe1 280nm 

excitation  

 FL2_280: 420-650nm fluorescence detected by FL2 detector with Xe1 280nm 

excitation  

 FL2_370: 420-650nm fluorescence detected by FL2 detector with Xe2 370nm 

excitation  

 Size:  Particle size in μm based on FL2 scattered light magnitude.  

 AF:  Asymmetry Factor; a measure of particle asphericity based on the azimuthal 

intensity variation of scattered light intensity detected by the four elements of 

the Quadrant detector  

 Particle rate in counts/sec: rate plots of Count T2 measured, Count T2 and 

Count T1, described above. The plotted rates are averaged over the preceding 

~5s period. 

 

5.2.2 Diagnostic Plots 

The WIBS-4A can display the following diagnostic plots: 

 

 Pwr_280: Magnitude of 280nm flash, a measure of xenon output stability. 

 Pwr_370: Magnitude of 370nm flash, a measure xenon output stability. 

 FL2 SctPk: Scattered 635nm laser light detected on FL2 detector and measured by 

peak detection. (Parameter used in determination of particle size). 

 FL2 SctInt: Scattered 635nm laser light detected on FL2 detector and measured by 

integration. (Parameter not currently used). 

 TOF:  Time-of-flight of particle through 635nm laser beam. There is a minimum 

allowable TOF, below which WIBS-4A electronics ignores signals assuming them to 

be due to noise. There is a maximum limit of TOF indicated by a yellow dotted 

line in the plot. This limit is the time in the measurement cycle at which the 

fluorescence measurement begins. Scattered 635nm light at this time will affect 

fluorescence measurements. Therefore measurements which carry the maximum 

TOF values should be treated with caution. Such measurements are tagged in the 

data output file. See element FT in section on data output file. TOF values longer 

than the maximum limit are recorded as the limit value. 

 TPC (Total Particle Counts): See elements TPCT1 and TPCT2 in section on data 

output file. 
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5.2.3 Menus 

The Plots window offers the user the following  

 

5.2.3.1 File Menu 

File > Save:  Save data currently recorded in plots.  

 

File > Save Visible:  Similar to “Save,” but only saves data within the time range actually 

visible on the plots.  

 

File > Load:  Load previously saved data.  

 

File > Replay:  Play back previously saved data. Data will appear progressively in plots as 

it did when originally recorded. A replay can be paused or aborted using appropriate 

options in the File menu.  

 

File > Clear on load:  If this is checked, any existing data in the plots will be cleared 

before new data is loaded.  

 

File > Recalc AF and Size on load:  The Size, AF and Particle rate plots are calculated 

from the data in other plots. If this menu item is checked, these plots are re-calculated 

rather than taken from the file being loaded.  

 

File > Trim lead time: Any newly loaded or newly acquired data is plotted after the 

latest plot time on the plots rather than starting from 0. If this menu item is checked, 

any lead time in a file to be loaded (i.e. time before the first particle measurement in 

the file) is trimmed avoiding potentially long gaps in the displayed data.  

 

5.2.3.2 Plots Menu 

Plots > Clear: Clear data from all plots.  

 

Plots > Export: Save plot images as windows meta files. 

 

Plots > Invert colors:  Alter the plot colors such that the background is white rather than 

black. (Useful for printing.)  

 

Plots > Show FT points:  If this is checked, Forced Trigger data will be shown on the 

plots along with the particle data.  

 

Plots > Point size:  Increase or decrease the size of plotted points.  
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Plots > Auto set offsets:  Automatically adjust offsets of fluorescence plots. This 

function is not normally used, but can be used while sampling non-fluorescing particles to 

offset the background level to 0. The offset for each plot is displayed to the right of the 

plot. Offsets can be adjusted manually by clicking the offset indicator and entering a new 

value in the window that appears.  

 

Plots > Scatter plot:  Display the scatter plot.  

 

Plots > Frequency plot: Display the frequency plot.  

 

Plots > Pwr_280 (and all other colored menu items):  Show or hide the relevant plot. 

Visible plots can also be hidden by right-clicking in the plot area of the plot.  

 

5.2.3.3 Alert Menu 

Enable or disable alert mode. If this is enabled, a visible and audible warning will occur if 

one or more of the five channels: FL2 SctPk, FL2 SctInt, FL1_280, FL2_280 or FL2_370 

goes above the alert threshold set for that channel. Alert thresholds can be set by 

clicking on the alert level indicator adjacent to the plot and entering a new level in the 

window that appears.  

 

5.2.3.4 Calibrate  

Not normally used, but can be used with calibration particles (PSL spheres or similar) to 

calibrate the particle Size and AF calculations made by the software.  

 

To calibrate Asymmetry Factor calculations  

 

Record data for some preferably monodisperse PSL spheres of size typically ~ 3μm. About 

500-1000 measurements will suffice for the calibration. In the Plots window, make sure 

the Scat_EL plot is displayed and adjust the time axis and scroll the plot so that all the 

recorded measurements are visible. Then click on the Calibrate menu and select the AF 

option. Appropriate normalization factors will be calculated for Scat_EL channels 2, 3 and 

4. These factors will be displayed in the Diagnostic info. textbox in the main Control 

Window. The new normalization factors will not come into effect until the next time an 

Acquisition function is started. To save the new factors for future use, click on the Save 

settings on exit option in the File menu of the main control window before closing the 

program.  
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5.2.3.5 Show Main Window  

 

Brings the main program window to the foreground if it is hidden. 

 

5.3 Scatter Plot 

The Scatter Plot Window () displays a scatter plot of particle data. The X and Y (and Z if 

3D option selected) axis parameters are user-selectable by right-clicking on any area in 

the plot to display a selection menu of available parameters for each axis of the scatter 

plot. 

 

 

Figure 12: WIBS-4A Scatter Plot 

5.3.1 Menus 

5.3.1.1 Axes Menu 

Use this menu to select 2D or 3D plot display.  

 

5.3.1.2 Points Menu 

Points menu > Point size increases or decreases the size of plotted points.  

 

Points menu > Point colors allows the user to select the desired color for plotted points.  
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Only points plotted after the selection is made are affected. The Color by Size option 

will color data points according to the legend used with the AF Plot in the Main Plots 

window. The Color by AF option will color data points according to the calculated 

particle AF. A legend for the colors is shown when clicking on the Color Key menu. The 

Color Timer Interval option allows the plot point colors to change periodically so that 

new points can be distinguished from older ones.  

 

Points menu > Max no. of points sets the maximum number of point the plot can 

display. If too many points are visible, the plot can slow the running of the program. A 

limit is therefore necessary on the amount of data that can be displayed.  

 

Plot menu > Copy to clipboard copies the displayed plot to the Windows clipboard.  

 

Plot menu > Clear clears all data in the plot.  

 

Plot menu > Change colors (3D mode only) opens a window allowing the display colors of 

the 3D plot to be altered.  

 

Plot menu > Toggle projection (3D mode only) switches the 3D plot between 

orthographic mode and 3D perspective mode.  

 

5.3.1.3 Color Key Menu  

This item shows the color key. The color key will automatically display color-coding for 

Size or AF depending on what is being displayed in the scatter plot.  

 

5.3.1.4 Show Main Window Menu 

This brings the main program window to the foreground if it is hidden.  

 

5.3.2 Other functions, 2D and 3D modes  

Right click on any area in the plot to display a menu allowing selection of desired 

parameter for each axis of the scatter plot.  

 

When double-clicking in the plot's plotting area, a pop-up menu appears indicating 

whether or not a filter of FL1/FL2 is being applied. If the FL1 280nm/FL2 280nm axis is 

being displayed, the FL1 280nm / FL2 280nm values can vary significantly because of 

noise when one of both of the data values is small. The filter removes the data where 

noise on either channel would have affected the FL1 280nm / FL2 280nm value 

significantly. Other plots are not affected.  
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5.3.2.1 2D Mode Only  

To zoom in on an area in the plot, use the mouse (left button) to draw a box from top 

left to bottom right around the area of interest. To un-zoom, draw a box from bottom 

right to top left anywhere in the plot area of the plot.  

To pan around the plot, hold the right button of the mouse down while over the plot area 

of the plot and drag the plot area up, down, left or right. When clicking on the X or Y axis 

a menu appears allowing the axis setting to be toggled between normal and logarithmic.  

5.3.2.2 3D Mode Only  

By dragging the mouse across the 3D plot while holding down the left mouse button the 

plot can be rotated to any desired viewing angle.  

 

5.4 Frequency Plot 

This plot (Figure 13) displays histogram plots for most of the data parameters. 

 

 

Figure 13: WIBS-4A Frequency Plot 
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The different parameters can be shown or hidden by typing the appropriate number or 

letter indicated by the text box at the bottom right of the plot. This text box can be 

hidden from view by clicking on it. It can be made to reappear by clicking on the plot 

legend.  

 

5.4.1 Y axis 

The Y axis is set to automatically scale to suit the data presented and allows no 

adjustment. 

 

5.4.2 X axis 

Min and max values can be adjusted by clicking on the axis and typing in new max and 

min values in the window that appears. A log axis option can also be selected in this 

window. 

 

The X axis bin size can be altered by right-clicking on the plot and selecting the 

appropriate pop-up menu that appears. The plot can also be cleared of data using this 

pop-up menu. 

6.0 Maintenance 

 
 

DANGER 

The laser used in the WIBS is a CLASS 1 Laser 

The standard laser operates at 635 nm and 12 mW. Do not open the 

WIBS cell unless the laser is turned off. 

Caution 

The use of controls, adjustments, or procedures other than those 

specified in this document may result in hazardous radiation exposure. 

In particular, reflections caused by placing an object in the laser beam 

path can cause skin burns and/or blindness. 
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6.1 Zero-Count Check 

A zero-count check should be conducted weekly or if issues are suspected. To conduct a 

zero check, place the zero-count filter and inlet adapter on the inlet. Run the instrument 

in Acquisition mode with the pump on for a minimum of five minutes. Particle counts 

should be less than 1 per liter after five minutes of operation with a filter in place. 

Remove the filter and adapter to resume normal operation. 

 

Users should also check the flow on a monthly basis. To check the flow, place a flow 

meter on the inlet. Run the WIBS in Acquisition mode with the pump on. The flow reading 

should be approximately 2.5 l/min.  

6.2 Cleaning the Inlet Assembly 

In the unlikely event that the aerosol inlet becomes blocked, it may be carefully removed 

for cleaning as described below. 

 

Figure 14: Cleaning the Inlet Assembly 
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Appendix A:  Specifications 

General Specifications 

Measured Parameters  Single-particle light scattering 

 Single-particle fluorescence (three separate 

measurements) 

 Particle Size 

 Particle Asymmetry Factor (AF) 

Derived Parameters Particle Concentration 

Particle Size Range 0.5 to 15 μm 

Maximum Concentration ~2 x 104 particles/L for full measurement 

(maximum is higher for particle counts only) 

Fluorescence Excitation Dual wavelength, 280 and 370 nm 

Fluorescence Emission Dual wavelength, 310-400 nm and 420 - 650 nm 

Flow Rate  Sample flow: 0.3 L/min 

 Sheath flow: 2.2 L/min 

Rear Panel Features  Power connection 

 ON/OFF LED 

 Pump status LED 

 Particle detection LED 

 Air sample outflow 

 USB connector 

 Laser 635 nm diode laser 

Laser 635 nm diode laser, 12 mW 

Pump Diaphragm pump 

Power Requirements 150 W, 90 - 230 VAC, 24 VDC 

 

Physical Specifications 

Weight 13.6 kg 

Dimensions  11.9” W x 15.1” L x 6.75” H / 

30.4 cm W x 38.2 cm L x 17.1 cm H 

Inlet adds an extra 1.5”/3.8 cm in height 
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Appendix B: Particle Size and Shape 

Determinations 

Particle Size 

Like most optical particle counters (OPCs), WIBS-4A uses a particle size calibration based 

on a theoretical curve that assumes the particles are spherical and of a specified 

refractive index (Mie theory). In the case of WIBS-4A, the calibration curve is based on 

aerosols of standard monodisperse polystyrene latex (PSL) microspheres. The refractive 

index of these spheres is quoted as 1.58 +/-0.2. 

 

Since this calibration curve is based on PSL spheres, the reported size should be taken 

only as an estimate when measuring spherical particles of different refractive index 

(e.g., water droplets) or non-spherical solid particles. 

 

The WIBS-4A Particle Size calibration curve for the normal setting (0.5μm – 15μm) is 

shown in Figure 15. The theoretical Mie curve (blue) is overlaid by a second-order 

polynomial (black line) that is used as the calibration function. The red squares show the 

WIBS-4A response to aerosols of PSL spheres of quoted sizes. 

 

 

Figure 15: WIBS-4A Size Calibration Curve 
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Particle Shape 

WIBS-4A incorporates an analysis of the forward scattered light captured by the Quadrant 

PMT to determine an index of particle shape, or more correctly, scattering asymmetry. 

This approach has been exploited by UH in a number of aerosol analysis instruments 

(e.g., references 8-12). The process used in WIBS-4A is illustrated in Fig. 9 below. 

 

 

Figure 16: Schematic diagram showing derivation of a particle Asymmetry Factor, AF, by measurement of the 

azimuthal variation in forward scattering from the particle. 

In Figure 16, examples of typical forward scattering patterns produced by particles of 

differing shape are shown in the top-right. These images were recorded using a high 

resolution intensified CCD camera. In WIBS-4A, a much simpler detector configuration is 

used, based on the quadrant PMT. This is for reasons of both cost and speed of response. 

The figure illustrates how the quadrant PMT would respond to particles of different shape 

– from left to right a droplet (spherical), fiber, flake, and irregular cubic particle. WIBS-

4A records the scatter intensity values received by each quadrant and determines the 

root-mean-square variation around the mean value to yield an Asymmetry Factor, AF, 

such that a perfect sphere would correspond to AF = 0, and a high aspect ratio fiber to an 

AF approaching 100. In reality, electronic and optical noise results in spherical particles 

having measured AF values ~2 to 6, rather than zero. Note: For particles less than 

~1.5μm, the AF value is inevitably increased as the signal-to-noise in the quadrant PMT 

outputs becomes very low for such small particle sizes. 

 

All AF data are provided in real-time to the user, but the 4 quadrant values are stored 

independently for later analysis by another method if preferred. 
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Appendix C: Output Files 

File Format 

The data output file is a text file with comma (csv) or tab (txt) separated variables 

depending on the selection made when saving. (It can be easily be opened in Excel as 

shown in the example below). The file has a number of header lines containing 

instrument configuration details and software at the time the file was written. There is 

also a line showing the time (time set on host computer) at which the file was begun. The 

data from each measured particle occupies one row in the file as shown below. These are 

described more fully below. 

 

 
 

 

Output Channels 

In addition to the three fluorescence values FL1_280, FL2_280 and FL2_370 recorded 

from each particle, and the FL2 scatter signal used for particle size determination, the 

WIBS-4A also records the four outputs from the forward-scatter Quadrant PMT used to 

assess particle shape. 
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The WIBS-4A also records the relative power of each xenon flash from the Xe1 and Xe2 

xenons. The manufacturer’s quoted pulse-to-pulse power variability is only +/- 3%, but 

the xenon output will decrease slightly in power over time. The Xe1_Pwr and Xe2_Pwr 

measurements allow correction to be made for this in the measured particle fluorescence 

values. Note that the xenons have a quoted minimum life-span before the power drops to 

50% of at least 109 pulses. This corresponds to approximately one year of continuous 24/7 

operation at typical aerosol concentrations. Replacement xenon units can be fitted when 

necessary. 

 

The particle data also includes the Particle time-of-flight (ToF) through the laser beam, a 

useful diagnostic to help eliminate particle coincidence events where a second particle 

may enter the laser beam before the first particle has left it. The particle Arrival Time at 

the scattering volume is also recorded to allow particle concentration assessment and the 

generation of the Particle Concentration History Plot in the display. 

 

Table 1 below summarizes the data that are recorded for each particle measured. 

Definitions for all the output channels appear after this table. 

 

Channel Description Purpose 

Xe1_Pwr Relative energy of Xe1 flash  Monitor Xe1 UV pulse energy  

Xe2_Pwr  Relative energy of Xe2 flash  Monitor Xe2 UV pulse energy  

Fwd Scatter  

Four signals from Quadrant- PMT : 

 Scatter ch1 

 Scatter ch2 

 Scatter ch3 

 Scatter ch4 

Used to assess particle shape  
 

FL2 scatter  Elastically scattered 635nm light onto FL2 channel  Used in particle size determination  

FL2 scatter  Fluorescence (~310 - 400nm) with 280nm excitation  

Intrinsic fluorescence  
  

FL2_280  Fluorescence (~420 - 650nm) with 280nm excitation  

FL2_370  Fluorescence (~420 - 650nm) with 370nm excitation  

TOF Particle time-of-flight through laser beam  Eliminating particle coincidence events  

Time stamp  Arrival time of particle at scattering volume  
Determining small-scale aerosol 
concentration variations 

Table 1: Data Recorded for Each Measured Particle 

 

 

Channel Definitions 

 

Data are arbitrary units unless otherwise stated. 

 

Time:  Count in milliseconds since start time of file. 
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FL2 SctInt: Scattered 635nm laser light detected on FL2 detector and measured by 

integration. 

 

Scat_EL1: Scattered 635nm laser light detected on quadrant 1 of forward scatter 

detector. 

 

Scat_EL2: Scattered 635nm laser light detected on quadrant 2 of forward scatter 

detector. 

 

Scat_EL3: Scattered 635nm laser light detected on quadrant 3 of forward scatter 

detector. 

 

Scat_EL4: Scattered 635nm laser light detected on quadrant 4 of forward scatter 

detector. 

 

FL2 SctPk: Scattered 635nm laser light detected on FL2 detector and measured by peak 

detection. 

 

FL1_280:  Fluorescence detected by FL1 detector after particle irradiation by 280nm 

light. 

 

FL2_280:  Fluorescence detected by FL2 detector after particle irradiation by 280nm 

light. 

 

Pwr_280:  Magnitude of 280nm flash. 

 

FL2_370:  Fluorescence detected by FL2 detector after particle irradiation by 370nm 

light. 

 

Pwr_370: Magnitude of 370nm flash. 

 

TOF: Time-of-flight of particle through 635nm laser beam. The WIBS electronics ignores 

events with TOF less than a preset value (typically 0.25μs) as these are deemed to be 

either noise spikes or very small particles < ~0.5μm in size. It also ignores events with 

TOF > ~10μs, as these elongated times of flight are principally due to particle coincidence 

events where a particle enters the beam before the preceding particle has left the beam. 

 

Total TPCT2:  The total number of particles producing a signal above Threshold 2 that 

may pass through the scattering volume each time the xenons are recharging (approx. 

5ms in duration). The number includes the count of measured particles. 
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Size:  An interpretation of particle size in μm based on the amount of scattered 635nm 

laser light detected by the FL2 detector according to the calibration function given in 

Appendix B. 

 

AF Asymmetry Factor:  A calculation of particle asphericity based on the balance of 

scattered 635nm laser light detected by the four elements of the Quadrant forward 

scatter detector. 

 

TotalT2:  Rolling average frequency of TPCT2. 

 

MeasT2: Rolling average frequency (averaged over the preceding ~5s) of the number of 

particles measured (i.e., full dataset of fluorescence, size, and asymmetry is acquired 

from particle). 

 

FT: The time of the measurement: 

 Bit 0: Forced Trigger mode (1), Acquisition mode (0). 

 Bit 1: FL2 PMT HIGH-GAIN (1), LOW-GAIN (0); note low-gain is disabled on the DMT 

WIBS-4A. 

 Bit 2: FIFO full (1), not full (0). 

 Bit 3: TOF upper limit exceeded (1), not exceeded (0) 

 

TPCT1:  The total number of particles producing a signal above Threshold 1 that may 

pass through the scattering volume since the time of previous particle ‘measurement’. 

This time includes the time the xenons are recharging (approx. 5ms in duration). The 

number includes the count of particles, measured or not, that produce a signal above 

Threshold 2 in this time. 

 

TotalT1:  Rolling average frequency of TPCT1. 

 

If a data file is created using the Save option in the File menu of the main Plots window, 

its structure is identical to that described above apart from the absence of the Start of 

file time indication. 
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Appendix D:  WIBS-4A Delivery Settings 
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Appendix E: WIBS 4 Optical Filters 
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Xe1 Filters 

FF01-280/20-25 

 

 
 

To deliver the 280nm UV pulse from Xenon 1, WIBS-4A uses two UV bandpass filters from 

Semrock Inc., type FF01-280/20-25. The transmission curve for a single filter is shown 

above. Two filters are used in series to improve out-of-band blocking and reduce the 

levels of infra-red transmission (where the xenon spectrum is still strong). 
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Xe2 Filters 

FF01-370/36-25 

 
To deliver the 370nm UV pulse from Xenon 2, WIBS-4A uses a UV bandpass filters from 

Semrock Inc., type FF01-370/36-25. The transmission curve for a single filter is shown 

above. 
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Dichroic Beamsplitter 

FF409-DiO2-25x36 

 
 
The dichroic beamsplitters helps separates the fluorescent light from the particle into 

two broad bands: 300-400nm (approx.) light is reflected to the FL1 channel and 400-

650nm (approx.) light is transmitted to the FL2 channel. 

 

However, the dichroic is not perfect and some of the 300-400nm light is transmitted and 

some of the 400-650nm light is reflected. This is why WIBS-4A uses additional filters in 

the FL1 and FL2 channels to reduce this unwanted light. 
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FL1 Channel 

FF01-300/25 

 

 
DUG11 
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FL2 Channel 

KV418 
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Quad-PMT Channel 

OG515 

 

 
 

The Quadrant PMT channel uses a single OG-515 long pass filter to significantly reduce 

the level of UV light reaching the PMT when the Xe1 and Xe2 xenons fire. It does allow 

the forward scattered light from the particle (635nm) to reach the PMT and be used in 

determination of the particle Asymmetry Factor. 

 

Appendix F: Removing WIBS-4A Cover for Access 

 

If for any reason access to the internal parts of the WIBS-4A is required, the WIBS-4A 

metal cover can be removed as described below. Note that while the WIBS-4A cover looks 

different in this diagram, the removal process is the same.  
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Appendix H: Revisions to the Manual 

 

Rev. Date Rev. No. Summary Section 

11-5-12 A Revised University of Hertfordshire manual Throughout 

5-29-13 A-1 Changed reference to Section 4 to Appendix B Appendix C 

8-14-13 A-2 
Corrected second fluorescence wavelength (360 nm to 370 

nm) 
Appendix A 

 

  

 


